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Wave Introduction
Agilent Seahorse XFe
Agilent Seahorse Wave is the experiment design, instrument control, data 
analysis, and file management software for Agilent Seahorse XF, XFe, and XFp 
Analyzers. This user guide provides detailed information on each function in 
Wave software.
Quick Start
The typical XF workflow can be outlined in three steps:

• Design your experiment

• Acquire data

• Analyze results

Design your experiment 

First, create an assay template file containing your experiment design. Wave 
software provides default assay template files for each Agilent Seahorse XF 
Assay Kit (for example, XF Cell Mito Stress Test). Start with a Seahorse default 
assay template file and customize as needed. Wave also provides a Blank assay 
template for those who prefer to create a fully-customized template file.

See “Create/Edit Assay Templates" on page 14 for more information on 
creating/customizing assay templates.

Acquire data

After creating an assay template file, transfer the template to the Seahorse XFe 
(or XFp) Analyzer using a USB flash drive or shared network drive (active 
network connection required). If the template is created using Wave Controller 
then the assay can be performed immediately on the XFe Analyzer.

Analyze results

After the XF assay is complete, transfer the data file, called an assay result file, 
from the XFe or XFp Analyzer to Wave Desktop for analysis.
96 and XFe24 Analyzers Wave 2.6 User Guide 3



Wave Home: Views
4

Templates 

View and organize your assay template files from the Templates view. Use the 
Create, Export, Import, and Duplicate buttons to manage your list of template 
files.

Results 

View, open, and manage all your assay result files from the Results view. Click 
the Options button to configure Favorite Places - file locations routinely visited 
where assay result files are stored (i.e.  shared network directory). 

Catalog 

Use the Catalog to store Compounds, Pretreatments, Media, and Cells that are 
frequently used for template design and modification. Wave provides a 
prepopulated Catalog containing every component available in the Seahorse 
XF Assay Kits, Seahorse XF Assay Medium, and other reagents cell types. You 
can add (and remove) Catalog entries from the Catalog view only.

Options 

Configure the local Template and Catalog file directories as well as the default 
Instrument Protocol times.

Help 

Agilent Cell Analysis Technical Support contact info, software version and 
auto-compile feature for System Files.

Figure 1 Wave Home views
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Wave Home: Templates 
Agilent Seahorse XFe
The Templates view displays all assay template files saved on the XFe 
Controller (Wave Controller) and on your PC (Wave Desktop). (See Figure 2.) 
An assay template (.asyt) file contains the required information to run an 
experiment on the XFe and XFp Analyzers - Group Definitions, Plate Map 
layout, and Instrument Protocol. Assay templates can be rerun for the same 
assay, or customized and saved as a new template for another assay on the 
XFe/XFp Analyzer.
Figure 2 Wave Home > Templates view
Assay templates are color coded based on the type of assay template. 
(See Table 1.)

Table 1 Assay templates

Template type Template color

Agilent Seahorse Blue

Blank White

User-customized Green
96 and XFe24 Analyzers Wave 2.6 User Guide 5



6

Wave software automatically installs several Seahorse template files 
containing specific assay-related information for each Seahorse XF Assay Kit. 
The blank and Seahorse templates are not editable; changes made to these 
templates will always be saved as a new assay template (green icon). (See 
Figure 3.)

Figure 3 Types of assay template files

Blank 
template

Agilent Seahorse 
default template

User-customized 
template
A
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Wave Home: Results 
Agilent Seahorse XFe
The Results view displays recently opened assay result files, the corresponding 
file directory where each assay result file is located, and Favorite Places. 
(See Figure 4.) Opening a new assay result file displays the default analysis 
view - the Quick View. After modifying and saving an assay result file, Wave 
automatically displays the last modified analysis view the next time the assay 
Results file is opened.
Figure 4 Wave Home > Results view
96 and XFe24 Analyzers Wave 2.6 User Guide 7
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1 Design XF Assays with Wave
Create/Edit Assay Templates
14
To create a new assay template or modify an existing template:

1 Open Wave 2.6.

2 Click Templates (below Wave Home).

3 Select the Blank template, a Seahorse template, or a user-customized template 
and click Open (double-click the template icon).

4 Add, remove, or modify group definitions; and create new assay groups. 
(See “Step 1: Group Definitions” on page 15.)

5 Assign groups to the Plate Map. (See “Step 2: Plate Map” on page 20.)

6 Review or modify Instrument Protocol. (See “Step 3: Instrument 
Protocol” on page 21.) 

7 Save the template, transfer it to XFe/XFp Analyzer. (See “Saving Assay 
Templates” on page 28.)

8 Run the assay. (See “Step 4: Run Assay” on page 24.)
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Design XF Assays with Wave 1
Step 1: Group Definitions
Agilent Seahorse XFe
Group definitions is comprised of four components: 

• Injection Strategies

• Pretreatments

• Assay media

• Cell type
Injection strategies

Figure 5 Group definitions 
Injection strategies describe the contents of up to four injections (one for each 
of the four ports: A, B, C, and D), more than one injection strategy can be 
performed in an assay. For example, on the same plate, two injection strategies 
can be defined for the XF Cell Mito and XF Glycolysis Stress Test.

To add one or more injection strategies:

1 Click Add next to Injection Strategies. (See Figure 5.)

2 Enter a name for the injection strategy if desired. The default name when 
adding new injection strategies is Inj. Strategy # (# corresponds to how many 
injection strategies have already been added).
96 and XFe24 Analyzers Wave 2.6 User Guide 15
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1 Design XF Assays with Wave
3 Next, specify the contents of each injection starting with Port A. Click 
Add Compound, and type in a compound name (for example oligomycin), or 
use the Compound Catalog drop-down menu to select a compound from the 
catalog. (See Figure 6.)
Figure 6 Assign injection ports
4 Repeat step 3 for injections from ports B, C, and D. 

Figure 7 shows two defined injection strategies for the Seahorse XF Cell Mito 
Stress Test for two concentrations of FCCP:

• Mito Stress Test - 1 µM FCCP 

• Mito Stress Test - 2 µM FCCP

Figure 7 Two injection strategies for the XF Cell Mito Stress Test assay
Pretreatments
Pretreatments describe a treatment the cells have received prior to performing 
the assay, such as a genetic manipulation or prolonged exposure to 
compounds.

To add one or more Pretreatments:

1 Click Add next to Pretreatments. (See Figure 8.)

Figure 8 Pretreatment conditions
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Design XF Assays with Wave 1

Agilent Seahorse XFe
2 Enter a name for the pretreatment or use the Pretreatment drop-down 
menu to select a pretreatment from the catalog. The default name when 
adding new pretreatments is Pretreatment # (# corresponds to how many 
pretreatments have already been added). Figure 8 displays two 
Pretreatment conditions, Control and Experimental.

3 If desired, specify the type of pretreatment using the Description field. 
Assay media
Assay Media describes one or more assay mediums used in the assay. Record 
the medium and supplements for each medium used in the assay:

To add one or more Assay Medium:

1 Click Add next to Assay Media. (See Figure 9.)

2 Enter a name for the assay media, or use the Media drop-down menu to 
select a media from the catalog. The default name when adding a new assay 
media is Assay Media # (# corresponds to how many assay media have 
already been added). (See Figure 9.)

3 Enter additional details if desired for: Source, Supplements, Prepared By, 
and so on. 

Figure 9 Assay Media 
Cell type
Cell Type describes the biological material/samples used, including 
information about the cell line, seeding density, and passage number.

To define one or more Cell Types:

1 Click Add next to Cell Type. (See Figure 10.)

2 Enter a name for the cell type or use the Cell Line drop-down menu to select 
a cell type from the catalog. The default name when adding a new cell type 
is Cell Type # (# corresponds to how many cell types have already been 
added).

3 If desired, enter additional details for: Seeding Density, Lot, Source, and 
Passage number.

Figure 10 Cell Type
96 and XFe24 Analyzers Wave 2.6 User Guide 17



1 Design XF Assays with Wave
Duplicate and Delete
18
The three dots next to each group definition enable two functions: Delete the 
group definition entry and Duplicate the group definition entry. 
(See Figure 11.)

Figure 11 Duplicate and Delete function toggle
Automatically generate groups
After creating the individual Group Definitions, create assay groups, and 
assign the various conditions to each group based on your experimental 
design. This can be done automatically by clicking the Generate Groups button. 
This function uses the independent Group Definitions to calculate the number 
of groups, assuming every possible combination of independent conditions. An 
example of the combinatorial logic using the Group Definitions below shows 
how this function results in a total of eight unique groups (2 * 2 * 1 * 2 = 8): 

• Injection Strategies = 2 (Mito Stress Test - 1 µM FCCP and Mito Stress Test - 
2 µM FCCP)

• Pretreatments = 2 (Control and Experimental)

• Assay Media = 1 (Mito Stress Test Assay Medium)

• Cell Type = 2 (C2C12 and HepG2)
Figure 12 Automatically generate groups 
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Design XF Assays with Wave 1
Manually generate groups
Agilent Seahorse XFe
If desired, Assay groups can be created manually: 

1 Click Add Group to create Group 1. (See Figure 13.)

2 Use the drop-down menus to assign the appropriate Group Definitions to 
Group 1. (See Figure 14.)

3 Repeat for each manually generated group.

To change the name of the group, double-click the Group 1 text, or right-click 
and select Edit. To change the color of the group, use the drop-down color menu 
next to the group name. After adding Group Definitions and generating 
groups, assign groups to the Plate Map. (See “Step 2: Plate Map” on page 20.)

Figure 13 Add groups

Figure 14 Duplicate and Delete function toggle
96 and XFe24 Analyzers Wave 2.6 User Guide 19



1 Design XF Assays with Wave
Step 2: Plate Map
20
The Plate Map displays group assignments on the Cell Plate. Wave uses the 
group assignments on the Plate Map to calculate group statistics (average rates 
for each measurement performed and the standard deviation or standard 
error for each rate measurement) after the assay has completed. There are two 
ways to assign groups to the Plate Map.
Assign groups automatically
Click Distribute Groups. Wave will automatically determine the maximum 
number of replicates per group, and assign wells to each group starting with 
column 1. (See Figure 15.)

Figure 15 Distribute Groups
Assign groups manually
1 Click the group in the Groups list on the left.

2 Click the well on the Plate Map to assign that individual well to the selected 
group. You can assign an entire row or column to a group by clicking the 
row or column label or drag-and-drop to select an area of the Plate Map to 
assign to the selected group. (See Figure 15.)
Background wells
Background wells have default Plate Map coordinates based on the type of XFe 
or XFp Analyzer. You can modify the coordinates of the background wells or 
add/remove background wells if desired. Use the steps described in “Assign 
groups manually”.
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Design XF Assays with Wave 1
Step 3: Instrument Protocol
Agilent Seahorse XFe
The Instrument Protocol is the series of commands performed during an assay, 
the timing of when these commands occur, and the duration. The default 
Seahorse assay templates have a preconfigured Instrument Protocol, and do 
not require modification.
Default protocol commands 
Every Instrument Protocol includes the following steps:

• Calibrate (always ON)

• Equilibrate (highly recommended for every assay)

• Baseline Measurement cycle

Calibration

Calibrate is always the first step in a protocol and cannot be disabled. The 
Calibrate step reads the coefficients of the Sensor Cartridge and Cell Plate to 
ensure accurate data acquisition.

Equilibration

Equilibration ensures temperature stability before beginning an assay. The 
default setting for Equilibration is ON. Equilibrate can be disabled although 
this is strongly discouraged.

Figure 16 Default protocol commands
96 and XFe24 Analyzers Wave 2.6 User Guide 21



1 Design XF Assays with Wave
Measurement cycles
22
Measurement cycles indicate the steps in the Instrument Protocol when rate 
data is collected for oxygen consumption rate (OCR) and extracellular 
acidification rate (ECAR). The standard Seahorse Instrument Protocol 
consists of three measurement cycles before the first injection (called 
Baseline) and three measurement cycles after each port injection. Each 
measurement cycle consists of three commands: Mix, Wait, and Measure.

• Mix: The amount of time to raise/lower the sensor cartridge to ensure 
analytes and drug compounds are uniformly mixed in each well before/after 
an injection, as well as to reintroduce oxygen to the well after forming the 
microchamber for each measurement.

• Wait: The amount of time to delay the Measurement step after the Mix step. 
This command is required for the XFe24 Analyzers in every assay but may 
be added to Instrument Protocol for any analyzer.

• Measure: The amount of time to record the flux of analytes in the transient 
microchamber once the sensor cartridge probes are lowered following a Mix 
(or Wait) command.

The default measurement cycle times are:

• Seahorse XFe96 & XFp Analyzer:
3 minutes Mix; 0 minutes Wait; 3 minutes Measure

• Seahorse XFe24 Analyzer: 
3 minutes Mix, 2 minutes Wait, 3 minutes Measure

Baseline measurement cycle 

The Baseline measurement cycle is the starting point for every Seahorse assay 
and consists of three measurements before the first injection. Data acquired 
during the Baseline measurement cycle provide valuable information about 
the bioenergetic status of the cells under starting conditions. 

Figure 17 Default cycles and timing
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Design XF Assays with Wave 1
Injections
Agilent Seahorse XFe
To add an injection command to the Instrument Protocol, click Injection. Wave 
automatically selects the compound injection ports sequentially, therefore, the 
first time you click Injection, port A will be assigned to injection 1. A grayed out 
port indicates it has already been assigned to an injection. (See Figure 18.)

Wave also automatically adds the measurement cycles after adding an 
injection. Default Mix, Wait, and Measure times are instrument-dependent, and 
can be modified in Instrument Options (Wave Home > Options).

Figure 18 Measurement information
Edit measurement details
To view and edit the Mix, Wait, and Measure timing, click the drop-down arrow 
next to Edit Measurement Details. (See Figure 18.) Use your keyboard to enter 
specific Mix, Wait, and Measure times or adjust the number of Cycles for each 
measurement. The up and down arrows can also be used. To achieve optimal 
results, a minimum of three cycles per measurement is recommended. The 
default Mix, Wait, and Measure times are instrument-dependent, and can be 
modified in Instrument Options (Wave Home > Options).

To change the name of each command in the Instrument Protocol, click the text 
field at the top of the column. (See Figure 18.)
Custom cycles
Most Seahorse assays do not require the use of custom cycles, however should 
your assay require a custom cycle this must be added during the Instrument 
Protocol step. To add a custom cycle command to the Instrument Protocol, click 
Custom. A custom cycle enables multiple Mix and Wait steps without a 
Measurement. Note that the Agilent Seahorse XF Report Generators are 
unable to analyze result data that contains a custom cycle.
96 and XFe24 Analyzers Wave 2.6 User Guide 23



1 Design XF Assays with Wave
Step 4: Run Assay

Assay summary
24
General Information 

The General Information section provides editable fields for project 
information, plate information, or other important notes related to the assay. 
Any information entered on this view is saved in the assay result file (*.asyr). 

Figure 19 Assay summary
Errors and Warnings 
All errors or warnings are displayed on the right side of the Run Assay step. 
(See Figure 20.) Prior to transferring the template to the XFe or XFp Analyzer, 
correct any errors that are displayed. A typical error message is the 
notification that some assay wells have not been assigned to a group on the 
Plate Map. If a template is designed correctly, Wave displays an All Set 
confirmation message. (See Figure 20.)

Figure 20 Errors & warnings
Advanced options 
Email settings (XFe Analyzers only)

This feature applies to Wave Controller software only and requires an active 
internet connection on the XFe Analyzer. Recipients must be added before 
starting an assay. Wave Desktop does not email assay result files. 
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Design XF Assays with Wave 1

Agilent Seahorse XFe
To add an email address: 

1 Open the template file.

2 On the Run Assay navigation step, click Show Advanced Options. 
(See Figure 21.)

3 Type in the email address below Email Settings, and click Add.

4 Repeat for each email address.

Port volumes and Version info

Adjust the default Port Volume values using the up/down arrows, or by typing in 
a value using your keyboard. This is for notation-purposes only and does not 
affect data calculations. (See Figure 21.)

Version Information displays the Wave software version along with Seahorse XF 
File version info (internal-use only). (See Figure 21.)

Protocol summary

To display a summary view of the Instrument Protocol, click Protocol. 
(See Figure 22.) To edit the Instrument Protocol, click the Instrument Protocol 
navigation step before running the assay on Wave Controller, or 
saving/transferring the assay template from Wave Desktop to the XFe or XFp 
Analyzer.

Figure 21 Advanced Options

Figure 22 instrument protocol summary
96 and XFe24 Analyzers Wave 2.6 User Guide 25
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1 Design XF Assays with Wave
Group summary

To display a summary view of the Group Definitions and Plate Map, click 
Group. (See Figure 23.) To edit the Group Definitions or Plate Map, click the 
Group Definitions or Plate Map navigation step before running the assay on Wave 
Controller, or saving/transferring the assay template from Wave Desktop to the 
XFe or XFp Analyzer.

Port (A, B, C, or D) summary

Click Port A (B, C, or D) for a summary of each injection from the selected port. 
(See Figure 24.) The summary information includes:

• Compound concentration

• Name of the solvent (if specified)

• Percentage of solvent used for each compound

• Port volume

Figure 23 Group definitions & plate map summary

Figure 24 Injection summary for Port A
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Design XF Assays with Wave 1

Agilent Seahorse XFe
To modify the compound name, compound concentration, solvent name or 
percentage, click the Group Definitions navigation step, then select the 
appropriate Injection Strategy to edit before running the assay on Wave 
Controller, or saving/transferring the assay template from Wave Desktop to the 
XFe or XFp Analyzer.

Print 

To print or save a PDF of the Assay Summary, Protocol, Group, and Port A-D 
summaries for the assay template, click Print Summary. 
96 and XFe24 Analyzers Wave 2.6 User Guide 27



1 Design XF Assays with Wave
Saving Assay Templates
28
After editing an assay template, click the Save button to overwrite the template 
with the newly modified details/content. To create a new template file, and 
preserve the original template file details, click the Save As button. 

Click Save As to display the Save As Template window (See Figure 26.): 

1 Enter the name of the assay template in the Name field (required). 

2 Enter the Author name (optional).

3 Enter a description of the assay in the Description field (optional).

4 Click Save. 

Figure 25 Save and Save as options

Figure 26 Save As window
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide
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This chapter applies to Wave Controller software for Seahorse XFe96 and 
XFe24 Analyzers ONLY. The functions described in this chapter do NOT apply 
to Wave Desktop or Seahorse XFp Analyzer software.

Creating an assay template file

Assay template files (.asyt) can be designed using Wave Desktop and Wave 
Controller. Assay templates created using Wave Controller can be run 
immediately after finished designing the template on the XFe Analyzer. Assay 
templates created using Wave Desktop must be transferred to Wave Controller 
to perform an assay -export the template file from Wave Desktop to a USB 
flash drive then import to Wave Controller software. If the XFe Controller has 
an active network connection, transfer template files using a shared network 
directory directly from Wave Desktop software.
29Agilent Technologies



2 Run Assay on the XFe Analyzer
Transfer Assay Template(s) to Seahorse XFe Analyzer
30
Several options to import assay templates to Wave Controller are outlined 
below.
Transfer assay template using a USB flash drive
Option #1:

1 Save template to a USB flash drive.

2 Plug the flash drive into the USB port on the Seahorse XFe Controller.

3 Select the USB flash drive and locate the template file(s).

4 Double-click the template to import automatically.

Option #2: 

1 Save template to a USB flash drive.

2 Plug the flash drive into the USB port on the Seahorse XFe Controller.

3 Click Templates.

4 Click Import.

5 Select the USB flash drive and locate the template file.

6 Select one or multiple template files on the USB flash drive, then click Open.
Transfer assay template using a shared network drive
Option #1:

1 Ensure that the XFe Controller is ON.

2 Start Wave Controller software.

3 Locate the assay template file in the shared network directory.

4 Double-click the assay template to automatically import to Wave Controller.

Option #2:

1 Ensure that the XFe Controller is ON.

2 Start Wave Controller software.

3 Click Templates.

4 Click Import.

5 Locate the template file in the shared network directory.

6 Select one or multiple template files on the network drive, then click Open.
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Run Assay on the XFe Analyzer 2
Start Your Seahorse XFe Assay
Agilent Seahorse XFe
When ready to begin your XFe assay, click Start Run in Wave Controller 
software. 

Once an assay is started, access to Wave Home and other assay template and 
CAUTION
result files is disabled until the assay is completed. Be sure to transfer any Seahorse 
files to another PC before starting an assay.
1 Click Start Run and select a location to save the assay template file (if it's a 
new template). The assay result file will be saved in the same location 
following assay completion. Assay template and result files can be saved to 
a USB Flash Drive, shared network directory, or locally on the XFe 
Controller. Wave Controller will also automatically save a backup assay 
result file locally on the XFe Controller in the location: C:\ProgramData\ 
Seahorse Bioscience, Inc\Seahorse Wave\Assays.

2 After choosing a save location, the tray door on the XFe Analyzer will open. 
Place the Sensor Cartridge (hydrated and loaded with compounds) along 
with the Utility Plate onto the tray. Ensure the Cartridge fits properly on 
the Utility Plate, the lid is removed from the Cartridge, and the direction of 
the Cartridge is in the proper orientation.

3 After loading the Sensor Cartridge and Utility Plate, press I’m Ready to 
initiate Sensor Cartridge Calibration. The time to complete Calibration for 
assays at 37 °C is approximately 10-20 minutes. For assays performed at 
temperatures other than 37 °C, an additional 30 minutes of pre-calibration 
time will be added to ensure accurate data acquisition.
Figure 27 Load Calibrant Utility Plate prompt
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4 After completing Calibration, Wave Controller will display the Load Cell 
Plate message prompt. Click Open Tray to eject the Utility Plate and load the 
Cell Plate. Ensure the lid is removed from the Cell Plate before loading.
Figure 28 Load Cell Plate prompt
5 Click Load Cell Plate to initiate Equilibration. Once Equilibration has 
finished, the assay will begin acquiring the first Baseline measurement. 
Figure 29 Load Cell Plate prompt
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Agilent Seahorse XFe
6 After completing the final Instrument Protocol step, the assay will finish 
and display an Unload Sensor Cartridge message prompt. To eject the 
Sensor Cartridge and Cell Plate from the XFe Analyzer, press Eject.
Figure 30 Unload Sensor Cartridge prompt
7 The assay result file will automatically save to the location specified prior 
to starting the assay, and can be opened immediately following the assay 
using the on-screen Assay Complete prompt. 
Figure 31 Assay Complete prompt
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Add and Remove Measurement Cycles in Runtime
34
Figure 32 Data acquisition runtime display on an XFe Analyzer
During an XFe assay, rate data is acquired, calculated and presented in 
real-time. For certain assays, it may be necessary to add additional 
measurements, or remove measurement cycles based on real-time responses in 
prior measurements. 

Wave Controller (version 2.4 and later) enables real-time Instrument Protocol 
modification to steps in the protocol that have not yet been executed. To 
display the Instrument Protocol for the selected command, click on an 
Instrument Protocol step above the data. (See Figure 33.)

Figure 33 Display instrument protocol information
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Agilent Seahorse XFe
Click Edit Measurement Cycles to display the Edit Number of Cycles window. 
(See Figure 34.) Use the up/down arrows (or manually type a number) to 
add/remove measurement cycles from the selected command. 

Figure 34 Add and remove measurement cycles for a specific instrument protocol step
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XFe Controller Best Practices
36
• Reboot the XFe Controller at least once per week. 
You may notice at times the Windows OS or Wave Controller software 
responding slowly. This can be due to an application over-using the 
computer’s resources (CPU, physical memory), memory leaks, or other 
low-level errors that have accumulated over time. Rebooting the XFe 
Controller resets the current state of Windows and software applications 
that may be causing any of the issues mentioned above. 

• Save & close open assay template files and assay result files prior to 
starting an XF assay. 
Like any software program, more computer resources (CPU & memory) are 
consumed when multiple files are open in Wave Controller software, even if 
the files are not actively being used. This could lead to instability of Wave 
Controller software, or even the Windows OS itself.

• Do not insert or eject USB flash drives (or insert/remove network cable) 
during an XF assay. 
If the target file save location for the assay result file is the USB flash drive 
or virus protection software starts scanning the USB. This could lead to 
instability of Wave Controller software and in some instances may result in 
data loss.

• Limit ‘data analysis’ performed on the XFe Controller, especially during 
an assay. 
XFe Analyzers acquire a significant amount of data for each assay, as 
mentioned above leaving files open in Wave Controller consumes computer 
resources, even if the files are not actively being used. Additionally, 
modifying the data display during an assay (i.e. changing from “Group” to 
“Well” mode, or “Rate” to “Level” mode) can redirect a significant amount of 
computer resources away from data acquisition, and in some instances may 
result in data loss. 

• Do not modify the Windows OS language setting.
The Windows Operating System language is set to English and cannot be 
modified. Changing this setting will significantly impact software 
functionality.
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Wave Controller Widgets
Agilent Seahorse XFe
The Widget icons are located on the lower left side of Wave Controller 
software, and display the status XFe Analyzer, current temperature, and 
controls to eject/insert the tray and raise/lower probes. 

t Status widget: Connection status between the XFe 
Controller (computer), Wave Controller (software), 
and the XFe Analyzer. 

Temperature widget: Current tray temperature 
and heater status display. 

Tray widget: Manually eject or insert tray, with or 
without a Utility Plate or Cell Plate. 

Probes widget: Manually unload a Sensor 
Cartridge and raise/lower the probes. 
XFe Assays at non-37 °C temperatures 
Seahorse XFe Analyzers have been validated to deliver desired target 
temperatures in the range of 16-42 °C provided the ambient room temperature 
is 12-20 °C below the target temperature, and in the validated operational 
room temperature range of 4-30 °C. To understand the relationship between 
the sample temperature and ambient temperature, see Figure 35 on page 38 
for the temperature chart.
Required operational and assay guidelines
• For all non-37 °C operation, the XFe Analyzer must equilibrate overnight in 
required ambient temperature.

• If required to set up the XFe Analyzer in cold room, avoid direct fan 
sources. (See Figure 35 on page 38.)

• For all non-37 °C operation, the tray heater must remain ON, do NOT turn 
the tray heater OFF.
96 and XFe24 Analyzers Wave 2.6 User Guide 37



38

2 Run Assay on the XFe Analyzer
• For assay temperatures below 30 °C, hydrate the Sensor Cartridge in the 
dark at room temperature. 

• Prior to starting an assay, an additional 30 minutes of precalibration 
equilibration time has been added to ensure temperature stability. 

To adjust the Target Temperature (set point) using the up/down arrows, click 
on the Temperature Widget to display the Tray Temperature window. 
(See Figure 36 and Figure 37 on page 39.) Ensure your ambient conditions 
support the desired target temperature (12-20 °C above ambient). Refer to the 
temperature chart shown in Figure 35. 

Figure 35 Temperature chart

Figure 36 Temperature widget 
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Changing the Target Temperature requires OVERNIGHT equilibration to the new set point.
NOTE
Other Temperature Widget functions are:

• Turn the heater ON/OFF.

• Set the tolerance range for temperature fluctuation. If the temperature is 
above or below the acceptable tolerance range from the temperature set 
point, the Temperature Widget will change color (see Figure 38), and the 
Status Indicator light (top of the XFe Analyzer) will change from blue to 
amber. For networked XFe Controllers, Wave Controller software will 
automatically send an email notification to specified recipients.

To save any changes on the Tray Temperature window, click Save.

Figure 37 Edit temperature settings window

Figure 38 Temperature out-of-range widget status
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Set alarm (Temperature tolerance range)
40
To set the alarm: 

1 Check the Alarm On box in the Tray Temperature window. (See Figure 39.)

2 Click Save.

Disable the alarm by unchecking the Alarm On box, then click Save. If the Tray 
Temperature exceeds the Tolerance Range and the alarm is activated, click 
Reset Alarm to acknowledge and reset the Tray Temperature alarm. 

To ensure the Tray Temperature starts within the Tolerance Range, check the 
current temperature of the XFe Analyzer before beginning an assay. For any 
suspected temperature issues or unexpected temperature fluctuations, contact 
Agilent Cell Analysis Technical Support.

Figure 39 Temperature Alarm
Tray control widget
Use the Tray Control Widget to manually eject a Utility Plate or a Cell Plate in 
XFe Analyzer:

1 Click the Tray Widget. (See Figure 40.)

2 Click Tray Out, and remove the Utility Plate or Cell Plate.

3 To insert the tray and maintain the Target Temperature, click Tray In.

Figure 40 Tray control widget
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Probe control widget
Agilent Seahorse XFe
Use the Probes Widget to load/unload a Sensor Cartridge or raise/lower 
probes. To display options and select the appropriate action, click the Probes 
Widget. (See Figure 41.)

Figure 41 Probes control widget
96 and XFe24 Analyzers Wave 2.6 User Guide 41



2 Run Assay on the XFe Analyzer
XFe Status Indicator
42
During an assay, the Status Indicator light on the top of the XFe Analyzer will 
change color if a task requires user interaction or if an error has occurred, 
such as:

• To load a Sensor Cartridge or Cell Plate

• To remove a used Sensor Cartridge and/or Cell Plate

• To accept or cancel an assay if one or more wells did not calibrate properly 
after Calibration

• Any errors that can occur during the run, such as barcode read errors for 
the Sensor Cartridge, Cell Plate, or a protocol error.
Barcode Errors
The XFe Analyzer reads and records the Cell Plate and Sensor Cartridge 
barcodes before beginning an assay. A Barcode Read error will be displayed on 
the rare occasion the barcode cannot be read. (See Figure 42.) Contact Agilent 
Cell Analysis Technical Support to assist with resolving this error and to start 
the assay. 
Cartridge barcode read failure
For any Sensor Cartridge barcode read errors, Wave Controller will display the 
message shown in Figure 42 and three corrective actions: 

• Open Tray: Eject the Sensor Cartridge to inspect barcode quality or to reverse 
the Sensor Cartridge.

• Manual: Manually input the Sensor Cartridge barcode information. Contact 
Agilent Cell Analysis Technical Support for this step. 

• Cancel Assay: Cancel the assay.

Figure 42 Barcode read failure 
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Manually enter sensor cartridge barcode

1 To display the Cartridge Barcode window, click Manual. (See Figure 43.) 

2 Call the appropriate regional Agilent Cell Analysis Technical Support 
telephone number to assist with entering the Sensor Cartridge barcode info 
for each field on the form. (See Figure 43.)

Figure 43 Cartridge barcode manual entry form
Cell plate barcode read failure
For any Cell Plate barcode read errors, Wave Controller will display the 
message shown in Figure 44 and two corrective actions: 

• Manual: Manually input the Cell Plate barcode info. 

• Cancel Assay: Cancel the assay.

Figure 44 Cell Plate Barcode Read Failure
96 and XFe24 Analyzers Wave 2.6 User Guide 43
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Manually enter cell plate barcode information

1 Click the Tray Widget. (See Figure 40 on page 40.)

2 To eject the Cell Plate, click Open Tray.

3 The Cell Plate barcode is located on the side of the plate. Write down the 
barcode information.

4 Click Close Tray.

5 On the Cell Plate Manual Barcode Entry window, enter the Cell Plate 
barcode, and click Accept. (See Figure 45.)

Figure 45 Cell Plate Manual Barcode Entry
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The primary purpose of Wave Desktop software is for data analysis of result 
files generated by Seahorse XF, XFe, and XFp Analyzers. Wave Controller 
software (for XFe Analyzers only) enables the same analysis features but 
performing analysis on the XFe Controller is strongly discouraged.
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3 Analyzing Assay Results
Assay Result Files
46
Assay result files (.asyr) are data files generated by XFe and XFp Analyzers 
after completing an XF assay. Types of data is acquired during an XF assay 
include:

• Rate data (OCR & ECAR)

• Level data (mmHg or mpH)

• Calibration results

• Consumable information from the barcodes on the cell plate and sensor 
cartridge used in the assay

In addition, any details added to the assay template file about the experiment, 
such as groups, compound, pretreatments, is transferred and saved in the 
assay result file. Most of this information can be edited using the Modify 
function. For more information, see “Modifying Assay Result Files" on page 76. 
After completing an XF assay, save the result file to a USB flash drive (or 
network directory), and open the result file using Wave Desktop 2.6 on your 
PC. The default analysis view for every new assay result file is called Quick 
View. Reopening a saved result file always displays the last-modified or viewed 
analysis view. Each analysis view can be added to an assay result file using the 
Add View button. The four analysis views in Wave software are: 

• Quick View

• Overview

• OCR vs. ECAR 

• Data 
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Analysis View #1 - Quick View
Agilent Seahorse XFe
Quick View is the default analysis view displayed when opening a new assay 
result file. Quick view simultaneously displays a kinetic graph of OCR vs Time, 
ECAR vs Time, and a scatter plot of OCR vs. ECAR. (See Figure 46.)

Figure 46 Quick view
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Analysis View #2 - Overview
48
Overview displays a kinetic graph of rate (OCR, ECAR, PER, or PPR) versus time. 
The selected rate is displayed on the y-axis, and Time is fixed on the x-axis. 
Group statistics (average rate and error) for each measurement can be 
displayed by checking the Details box in the Group List below the kinetic graph. 
Overview is the most versatile analysis view in Wave software for most routine 
analysis functions. To display Overview, click Add View in the center of the 
ribbon menu, and select Overview from the list of views. (See Figure 47.)

Figure 47 Overview

Add multiple Overview analysis views by repeating the process of Add View > Overview. 
NOTE
This gives greater flexibility for tailoring your result data presentation to show specific 
groups, responses, or comparisons between groups.
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Analysis View #3 - OCR vs. ECAR 
Agilent Seahorse XFe
The OCR vs. ECAR view displays the OCR on the y-axis and (by default) ECAR on 
the x-axis. To display OCR vs. ECAR, click Add View in the upper-left region of the 
screen, and select OCR vs. ECAR from the drop-down menu. Use the rate 
drop-down menu to change the rate displayed on the x-axis to either PER or 
PPR. OCR is always displayed on the y-axis, and cannot be changed. 
(See Figure 48.)

Graph title and Quadrant labels

The default graph title is Energy Map. (See Figure 48.) The corners of the 
Energy Map have labels representing the relative bioenergetic state of the 
group(s) related to each other for the selected rate measurement. To modify 
the graph display, including the Graph Title and the Quadrant Labels, click the 
Settings cog. (See Figure 49.)

Dual rate display on Plate Map

The Plate Map displays two rate measurements within each well (OCR vs. 
ECAR, OCR vs. PER, or OCR vs. PPR) as indicated by the legend below the 
Plate Map. (See Figure 48.)

Figure 48 OCR vs. ECAR

Figure 49 Graph display options
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Chart Types in Wave

Kinetic graph (rate versus time)
50
A kinetic graph is the most common way to display rate data from XF 
Analyzers. (See Figure 50.) The kinetic graph displays the rate measurement 
on the y-axis, and the time on the x-axis. During an assay, data is acquired and 
plotted in real-time as a kinetic graph. Kinetic graphs are also found in the 
Quick View and Overview analysis views.
Figure 50 Kinetic graph
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Scatter plot (rate 1 versus rate 2)
Agilent Seahorse XFe
Another common way to express result data is a scatter plot of OCR vs. ECAR, 
where OCR is plotted on the y-axis, and ECAR plotted on the x-axis. (See 
Figure 51.) Data points are displayed on the OCR vs. ECAR scatter plot for a 
single rate measurement for each group in the assay. The OCR vs. ECAR graph 
is only available for analysis, not while running an XF assay.
Figure 51 Scatter plot
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Plate Map 
52
The Plate Map displays rate data for the selected rate measurement of each 
assay well. (See Figure 52.) Plate Maps are always displayed in the upper right 
corner of Wave while running an assay, and on the Quick View, Overview, OCR 
vs. ECAR analysis views. The Quick View has a button to display the Plate Map, 
which is hidden by default. The default rate measurement displayed on the 
Plate Map is rate measurement 1. 

To change the measurement displayed in the Plate Map, use the Measurement 
drop-down above the kinetic graph or scatter plot. (See Figure 53.) The Rate 
Highlight tool on the kinetic graph will move to the selected rate. Hide the Rate 
Highlight tool by clicking Options above the kinetic graph/scatter plot, and 
uncheck Show Rate Highlight.

Figure 52 Plate map

Figure 53 Rate measurement drop-down menu
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Agilent Seahorse XFe
Flag wells on the plate map

Right-click a well on the plate map to display the add/remove flag function. 
(See Figure 54.)

Use the flag function to highlight specific responses, data points, or entire 
groups on the plate map for follow-up analysis or investigation.  Flags are an 
analysis feature only and can be added from the following analysis views - 
Quick View, Overview, and OCR vs. ECAR. The flagging function is not 
available when running an assay, or in Wave software versions below 2.6.

When a flag is added or removed in an analysis view, other open analysis views 
will automatically update the flag status. The flag status will also persist to 
any newly-added analysis views in the result file. This feature is not available 
in versions of Wave software before 2.6.

Figure 54 Right-click menu option to add/remove well flags
Bar Graph
The Bar Graph below the Plate Map displays the average rate for each group 
(by default) for a selected measurement. (See Figure 55.) Use the Display 
drop-down menu to change the rate display from Group (average) to Well 
(individual well) mode. 

The Bar Chart graph is only available in analysis, not while running an assay. 
The Bar Chart view provides another way to view individual measurement 
result data for all groups. The bar chart view is particularly useful for 

Figure 55 Bar graph
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identifying outliers, optimal FCCP concentration, optimal cell seeding density, 
or other trends that may not be apparent when measurement data is plotted as 
a kinetic graph. 
Group List (legend)
The Group List is the legend for the data plotted in the kinetic graph/scatter 
plot. (See Figure 56.) It provides several functions to modify the data plots:

• Hide groups from the data plot by double-clicking the name of the group. To 
unhide the data from the graph, double-click the hidden group again. When 
a group is hidden, the mean and standard deviation of the group will be: 
Mean: 0.00 and Standard Deviation: 0:00.

• Display group statistics for the selected rate measurement by checking the 
Details box in the upper-right corner of the Group List. Statistics are 
displayed as average and error for the selected rate measurement. Select a 
different rate measurement to display group statistics for that rate. Assay 
wells that have been turned OFF on the Plate Map are not included in the 
calculated group statistics. 
Figure 56 Group list
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Types of Data in Wave

Rate data: OCR and ECAR
Agilent Seahorse XFe
Use the Rate drop-down box to view the rate data options. (See Figure 57.) The 
two rates measured by the Seahorse XF Analyzers during an assay are:

• Oxygen Consumption Rate (OCR); Units: pmol/min

• Extracellular Acidification Rate (ECAR); Units: mpH/min

Figure 57 Rate selection drop-down menu
Level data: O2 and pH
To view Level data for O2 and pH levels for each rate measurement during the 
assay, use the Y1: drop-down. (See Figure 58.) The O2 level data is displayed as 
oxygen tension in units of mmHg. As the biological material in the well 
consumes oxygen during a measurement, the oxygen tension will decrease. 
This decrease in oxygen tension is used to calculate the rate of oxygen 
consumption (OCR). The pH level data displays the changes in mpH for each 
rate measurement and is used to calculate ECAR. Level data can be displayed 
while running an assay, and on the Overview and Data analysis views.

Figure 58 Y1 Drop-down

Figure 59 Oxygen Consumption Rate (OCR) data in Rate mode (left). 
Oxygen tension (O2) data displayed as mmHg in Level mode (right).
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Introduction to Acidification Data
56
The Seahorse XF Analyzer sensor probes measure changes in the 
concentration of free protons in the microchamber in real-time; this data is 
referred to as Extracellular Acidification Rate (ECAR). ECAR can be 
transformed into a number that reflects the number of protons extruded over 
time, Proton Production Rate (PPR), and Proton Efflux Rate (PER). Table 2 
shows the types of acidification data.

Table 2 Types of acidification data

Type of acidification data: ECAR PER PPR

Detects acidification from all sources? Yes Yes Yes

Changes with media formulation? Yes No No

Accounts for buffer factor of the system? No Yes No

How buffering is accounted for? None Buffer factor Buffer capacity

Displayed while running assay? No No No
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Proton Efflux Rate 
Agilent Seahorse XFe
PER is a new rate measurement calculated in Wave software (versions 2.4 and 
later). PER delivers a quantitative measure of extracellular acidification and is 
only available in post-run assay results. It is not displayed while running an 
assay. ECAR is the default reported acidification data in Wave software. The 
three rate options displayed in the Rate Measurement drop-down menu are: 
OCR, ECAR, and PER (previously PPR was the default). To change the 
reported acidification data option to PPR, use the Options menu under Wave 
Home. PER is calculated using the following equation: 

PER (pmol H+/min) = ECAR (mpH/min) × B.F. (mmol/L/pH) × Geometric Volume (µL) × Kvol

Wave software calculates and reports total PER on the Overview, OCR vs. 
ECAR, and Data analysis views for the following XF Analyzers: XFe96, XFe24, 
XFp, and XF96. Use the Rate Measurement drop-down menu to select PER as the 
rate to display on the kinetic graph (Overview analysis view), or scatter plot 
(OCR vs. ECAR analysis view). To correctly calculate and display PER, the 
buffer factor of the system (and all assay wells) must be known. What will 
automatically display PER if the following conditions are true:

• The Buffer Factor was automatically read from the sensor cartridge. If you 
are analyzing data from an older result file, the buffer factor may not be 
encoded in the barcode label and must be added manually to the file. 

Table 3 Wave volume variables

Variable Unit Description

Extracellular Acidification 
Rate (ECAR)

mpH/min Rate data measured during an assay, reported as 
the rate of change in mpH in an assay well. 

Buffer Factor (BF) mmol/L/pH Measure of the in situ buffer capacity obtained in 
XF instruments, and accounts for both medium 
buffer capacity and XF assay conditions.

Geometric volume µL Physical (geometric) volume of the measurement 
microchamber.

Volume scaling factor (Kvol) No units Volume scaling factor used to account for total 
proton production in the measurement chamber.
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• The assay media assigned in the assay template file is one of the following:  

• Glycolytic Rate Assay Medium (DMEM-based)

• Glycolytic Rate Assay Medium (RPMI-based)

• Seahorse XF DMEM Medium, pH 7.4

• Seahorse XF RPMI Medium, pH 7.4

The equation displayed above Table 3 shows the PER calculation equation - the 
only modifiable variable in the equation is Buffer Factor. A default Buffer 
Factor is automatically used for the PER calculation. If you are using a custom 
assay medium then Buffer Factor must be determined manually. Refer to the 
Agilent Seahorse XF Buffer Factor Protocol (available in the XF Glycolytic 
Rate Assay Report Generator download folder and the XF real-time ATP Rate 
Assay Report Generator download folder) for guidance.

Older result files in which the Buffer Factor is not included will show zero for 
PER. PER will not be displayed:

• For XF24 and XF24-3 sensor cartridges

• For Spheroid and Islet plate types

• For assay template/assay result files that do not have the Seahorse assay 
medium from the Catalog assigned (Seahorse XF DMEM or RPMI Medium, 
pH7.4 or Glycolytic Rate Assay Medium (DMEM-based or RPMI-based) 

• If the Buffer Factor value is not entered (for older result files)

• When background well Buffer Factor values have not been configured.
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Display PER data in Wave
Agilent Seahorse XFe
1 Open the assay result file in Wave software.

2 Click Modify.

3 Click Add next to Assay Media. (See Figure 60.) 

4 To select the assay medium, use the Media catalog drop-down menu. 
(See Figure 61.)

• Seahorse XF DMEM Medium, pH 7.4

• Seahorse XF RPMI Medium, pH 7.4

• Glycolytic Rate Assay Medium (DMEM-based)

• Glycolytic Rate Assay Medium (RPMI-based)

Figure 60 Assay Media option

Figure 61 Assay medium media menu
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5 To configure Background Well Buffer Factor, click Assay Media. (See 
Figure 62.)

6 Click Configure.

7 Under the column header Default Buffer Factor, check the boxes next to each 
background well, and click Save. (See Figure 62.)

Figure 62 Configure background buffer factor 

When editing your assay template file follow steps 5-7 above to configure the background 
NOTE
well buffer factor before running an XF assay.
8 Assign the Assay Media to each group in the group list. First click 
Collapse/Expand All to display the Group Definitions for each group. 

9 Use the Media drop-down menu to add the assay media to each group 
(Seahorse XF DMEM or RPMI Medium, pH 7.4; or Glycolytic Rate Assay 
Medium (DMEM-based or RPMI-based)).

10 When finished, click Apply.

11 The kinetic graph and scatter plot will display PER data when selected 
using the Rate drop-down menu.

Figure 63 Media drop-down menu
Agilent Seahorse XFe96 and XFe24 Analyzers Wave 2.6 User Guide



Analyzing Assay Results 3

Agilent Seahorse XFe
12 When finished with analysis, save the changes made to the result file. If the 
background well buffer factor values have not been configured, Wave will 
show an "attention" icon next to the rate measurement drop-down menu. 
(See Figure 64.)

Figure 64 Alert when background well buffer factor is not configured
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Display PER for assays run with custom assay media

Prior to running the assay, calculate the Buffer Factor of the custom assay 
medium. Follow the steps in the Agilent Seahorse XF Buffer Factor Protocol 
(available in the XF Glycolytic Rate Assay Report Generator download folder 
and the XF Real-Time ATP Rate Assay Report Generator download folder) for 
guidance.

1 Open the assay result file in Wave software.

2 Click Modify.

3 Click Add next to Assay Media.

4 In the Edit Assay Medium window, enter the Buffer Factor in the field 
provided.

5 Next, click Assay Media again to configure Background Well Buffer Factor.

6 Click Configure.

7 Under Buffer Factor (mmol/pH), type in the same Buffer Factor value and 
click Save. (See Figure 65.)

8 Assign the Assay Media to each group in the group list. First click 
Collapse/Expand All to display the Group Definitions for each group. 

9 To select the appropriate medium for each group, use the Media drop-down 
menu.

10 When finished, click Apply.

11 The kinetic graph and scatter plot will display PER data when selected 
using the Rate drop-down menu.

12 When finished with analysis, save the changes made to the result file.

Figure 65 Configure background buffer factor
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Data Analysis Using the XF Glycolytic Rate Assay Report Generator
Agilent Seahorse XFe
Wave software calculates and reports total PER. If you performed the 
XF Glycolytic Rate Assay, you must export data to the XF Glycolytic Rate 
Assay Report Generator to calculate glycoPER, the rate of glycolysis-specific 
proton efflux. (See Figure 66.)

1 Open the assay result file in Wave software.

2 Calculate PER.

3 Click Export.

4 Select the XF Glycolytic Rate Assay Report Generator from the list of export 
options.

5 Click Save to create the XF Report Generator file.

Figure 66 Export to the XF Glycolytic Rate Assay Report Generator
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Calculate ATP Production Rates
64
Wave software calculates and reports total PER only; it does not calculate 
rates of ATP production from mitochondria or glycolysis. If you performed the 
Agilent Seahorse XF Real-Time ATP Rate Assay, you must export data to the 
XF Real-Time ATP Rate Assay Report Generator. (See Figure 67.)

1 Open the assay result file in Wave software.

2 Calculate PER.

3 Click Export.

4 Select the XF Real-time ATP Rate Assay Report Generator from the list of export 
options.

5 Click Save to create the XF Report Generator file.

Figure 67 Export to the XF Real-Time ATP Rate Assay Report Generator
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Export total PER data 
Agilent Seahorse XFe
PER data is exported to both Microsoft Excel and GraphPad Prism file exports. 
(See Figure 68.) For manual PER data analysis or graphing purposes, export 
data from Wave to either file type using the Export function located in the 
top-level ribbon. 

Figure 68 Prism data export examples 

GraphPad Prism Microsoft Excel
96 and XFe24 
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3 Analyzing Assay Results
Proton Production Rate
66
PPR is calculated in Wave software using the following equation:

PPR (pmol H+/min) = ECAR (mpH/min) × Buffer Capacity (mol/L/pH) × Geometric Volume (L)
Report PPR data in Wave
The default Acidification Data displayed in Wave software is PER. PPR is not 
available for selection in the Rate Measurement Drop-Down Menu until it is 
enabled in the Wave General Options:

1 Open Wave software.

2 Click Options.

3 Under General Settings > Acidification Data click the radio button next to 
Report PPR; Use Buffer Capacity (mol/L/pH).

4 Click Save.

5 Close/reopen Wave software for the changes to take effect.
Display PPR data in Wave
Wave software reports PPR data on the Overview, OCR vs. ECAR, and Data 
analysis views when enabled, and is calculated using ECAR data and Buffer 
Capacity of the assay medium used. 
Buffer capacity
Buffer Capacity is required for calculating PPR from acquired ECAR data. 
Buffer Capacity changes based on the constituents of the medium. Individual 
constituents have different abilities to buffer the medium from pH changes. 
For accurate PPR data, the Buffer Capacity of each medium used must be 
measured and entered on Modify > Group Definitions tab in an assay result file. 

Record Buffer Capacity of an individual assay medium: 

1 Open an assay result file.

2 Click Modify > Group Definitions.

3 Double-click Assay Media (if an assay medium is not specified, use the Add 
button to add an assay medium).
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4 Click the assay medium and enter the Buffer Capacity value. (See Figure 69.) 
If no Buffer Capacity is entered, the default value of 0.00078 is used. If more 
than one assay medium is used, repeat the same steps for each additional 
media.

Record Buffer Capacity for background wells

1 Double-click Assay Media below Group Definitions. 

2 Click Configure. 

3 In the Configure Background Buffer Capacity window, type in the Buffer 
Capacity value for each background well listed. (See Figure 70.) If only one 
assay medium is used, enter the same Buffer Capacity value. If more than one 
assay medium is used, enter the Buffer Capacity of the assay medium for the 
appropriate background well. 

Figure 69 Buffer Capacity in Wave

Figure 70 Configure background buffer capacity
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Baseline to a Rate Measurement (%)
68
The Baseline function in Wave software enables rate data to be expressed as a 
percent of (1) a selected rate measurement or (2) a percent of a control group. 
This feature is available on the Overview and OCR vs. ECAR analysis views 
only). To express kinetic data as a percent of a selected rate measurement for 
all groups, use the Baseline drop-down menu and select a Rate measurement. 
(See Figure 71.)

Figure 71 Baseline to a rate measurement

Raw OCR kinetic data expressed as (pmol/min)

OCR kinetic data expressed as a percent of rate measurement 3 (%)
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Baseline to a Control Group (%)
Agilent Seahorse XFe
To display rate data as a percent of a Control Group, using the same baseline 
drop-down menu scroll down to display and select your Control group. The 
example in Figure 72 shows how this feature can provide a better graphical 
representation of the effect of glucose inhibition on OCR and facilitate data 
interpretation.

A Control group (blue line) with only media injections is selected as the 
baseline control group. After selection, each rate measurement in the groups 
"Glucose Dependency" (orange line) and "Glucose Capacity" (green line) is 
expressed as a percentage of the rate measurement of the Control group. 

Figure 72 Baseline to Control group

Raw OCR kinetic data for the XF Mito Fuel Flex Test 
expressed as (pmol/min)

OCR kinetic date for the XF Mito Fuel Flex Test expressed as 
a percent (%) of the selected Baseline group (Control group)
9
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Standard Deviation and Standard Error of the Mean
70
Two types of error bars in Wave are Standard Deviation (StdDev) and Standard 
Error of the Mean (SEM). Use the Error Format drop-down menu to change the 
error bar type displayed on the kinetic graph/scatter plot and the Group List. 
(See Figure 73.) to hide error bars from the data graph, select None. In Well 
mode, error bars are not displayed.

Figure 73 Error Format menu
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Rate Overlay: OCR, ECAR, PER, PPR, O2, or pH 
Agilent Seahorse XFe
Compare two sets of data (rate and/or level) on one kinetic graph using the 
Y2 drop-down menu. This will overlay the Y2 data with the selected Y1 data. 
(See Figure 74.)

Figure 74 Y2 rate overlay
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Customizing Data Displays

Excluding assay wells 
72
By default, data from all assay wells is displayed on the kinetic graph(s) after 
opening a new assay result file.  Click an assay well on the Plate Map to 
exclude (or include) that well in the graphed data and calculated group 
statistics for that group. Assay wells that are turned off on the Plate Map have 
a grey background. Assay wells that are included in graphed data and 
calculated group statistics have a white background. (See Figure 75.) Assay 
wells must be manually turned off from each analysis view, turning off an 
assay well on one analysis view is not automatically applied to other open (or 
new) analysis views.

Column and row headers can be used to exclude entire vertical or horizontal 
sections of a Plate Map. Click the numerical column header or alphabetical 
row header to turn the assay wells in that column or row OFF. 

Click the small triangle in the upper-left corner of the Plate Map to turn off all 
assay wells from the graphed data. (See Figure 76.)

Figure 75 Two states of assay wells

Figure 76 Corner toggle to turn OFF all wells on the Plate Map

The upper 2 assay wells in this 
group are turned OFF and 
excluded from the graphed data 
and group statistics. 

All assay wells in this group are 
included in the graphed data and 
group statistics. 
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Display modes: group and well
Agilent Seahorse XFe
Rate data is graphically displayed in Group mode on all analysis views by 
default. Group mode displays a single kinetic trace for each group on the 
Overview analysis view, and a single data point each rate measurement per 
group on the OCR vs. ECAR view. In Group mode, error within each group is 
displayed as Standard Deviation or Standard Error of the Mean. Switch to Well 
mode to display individual kinetic traces (or data points for OCR vs. ECAR 
view) for each assay well assigned to the group. Error bars are not displayed in 
Well mode.

Figure 77 Example of an OCR kinetic graph in Group (average) and Well mode

Group mode

Well mode
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Resize and Adjust view areas 

View areas on the different analysis views can be adjusted in two ways: using 
the gray borders (red arrows in Figure 78) and the << and >> arrows (outlined 
in red in Figure 78) to hide entire regions of the view (Overview pictured in 
Figure 78). Use the border between the kinetic graph and Plate Map to 
elongate/shrink the graph or Plate Map size.  Hide the Group List to increase 
the vertical size of the kinetic graph using the border between the kinetic 
graph and Group List. Hide the Bar Chart using the border between the Plate 
Map and Bar Chart.
Figure 78 View areas
Zoom, Pan, and Restore 

The Zoom, Pan, and Restore buttons are displayed above the kinetic graph on 
the Overview and the scatter plot on the OCR vs. ECAR view.

Zoom Right-click and hold to select an area on the kinetic 
graph or scatter plot to magnify the selected area.

Pan After zooming into a section of a graph, use the Pan 
button to move around the graph while keeping the 
selected zoomed display aspect ratio.

Restore Return the graph to full view.
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Graph display options
Agilent Seahorse XFe
To show the graph display formatting options menu, click the cog next to the 
restore button. 

• Minimum and Maximum: Set the minimum and maximum bounds for the Y1, 
Y2, and X-axes.

• Interval: Set the major units for the Y1, Y2, and X-axes.

• Thickness: Add and adjust thickness of Y1, Y2, and X-axes gridlines. Adjust 
values in 0.50 intervals. Default value is '0.00' (no gridlines displayed).

• Show Error Bars: Toggle error bars ON/OFF. 

• Show Zero Line: Display a horizontal reference line at the zero when the 
y-axis is negative.

• Point-to-Point: Display point-to-point rates for the selected axis.

• Show Rate Highlight: Toggle ON/OFF display of the vertical blue rate 
highlight bar on the kinetic graph (indicates the selected rate measurement 
that corresponds to values displayed on Plate Map).

• Show Injections Marker: Toggle the vertical injection lines on the kinetic 
graph ON/OFF.

Figure 79 Graph display options
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Modifying Assay Result Files
76
Click Modify (in the Functions ribbon) to add or edit details of an assay result 
file. Modify is most-frequently used to add important experiment notes after 
the assay, or update details of the Group Definition (group names, , 
pretreatment details, reassign wells to a different group, or unassign assay 
wells from the Plate Map entirely). The Group Definitions view is always 
displayed first when entering Modify mode. 

The views in Modify mode look nearly identical to the template designer views. 
When actively modifying an assay result file, Wave will indicate the program is 
in Modify mode in the upper-left corner of Wave. To return to assay result data, 
click Apply (upper-right corner of Wave) to apply modifications to the result 
file, or click Cancel to cancel out of Modify mode and prevent any changes from 
taking effect.

The Modify function does not enable editing result data acquired during the assay.
Group definitions

NOTE
To display the Injection Strategies, Pretreatments, Assay Media and Cell Type 
details entered in the assay template prior to running the assay, select Group 
Definitions. Modifications to the Group Definitions tab include: 

• Renaming assay groups

• Reconfigure details for one or more groups

• Add additional group information that was left out of the initial assay 
template design, or 

• Add Buffer Factor to calculate PER
Plate Map 
To display and edit conditions of each assay group using the drop-down menus 
below the group name, select Plate Map. This tab also enables reassigning group 
locations on the Plate Map. Select a group, then select the appropriate assay 
wells on the Plate Map.
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Injection Names 
Agilent Seahorse XFe
To edit the name of each compound injection during the assay, select Injection 
Names. The specified injection names from the Instrument Protocol tab are 
displayed above each injection line on a kinetic graph. The default name of 
each injection is: 'Injection 1', 'Injection 2', Injection 3', and 'Injection 4'. Type 
an Injection Name for each compound injection, and click Apply to display the 
new name above the corresponding injection line. 
General Information 
To edit details of an assay result file, such as: Project Name, PI, Well Volume, or 
Port Volumes, select General Information. 
Normalization
In the context of an XF assay, normalization is the process of recalculating rate 
data to account for variations in a relevant cell parameter (such as cell count 
or protein concentration) that can cause well-to-well variability. The 
Normalization function in Wave provides a simple method to apply 
normalization data to the acquired rate data. To use the normalization 
function, an independent assessment of the assay wells for cell number, DNA 
content, protein concentration or similar parameter is required. (See 
Figure 80 on page 78.)

To normalize data in Wave, three components are used:

• Normalization Values (required): The numeric data generated from the 
independent assessment of the well (cell count, protein concentration, DNA 
content, and so forth).

• Normalization Unit (required): This alphanumeric field describes the 
units to which the data are to be normalized. It comprises the desired value 
to which the data will be normalized (see Normalization Scale Factor) plus 
the unit of measure of your normalization values (such as “cells”, “mg”, 
“ng”, and so forth).

• Normalization Scale Factor: This number determines what value the rate 
data will be normalized to. Default is 1 and adjustment is optional.
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Figure 80 Edit & apply normalization data
Add normalization values
Click Normalize (in the Functions ribbon) to display the Edit Normalization 
Mode. The Normalization Values table is the place to copy/paste normalization 
data in Wave. Two ways to add normalization data are:

Option #1:

1 Open the normalization data file. Normalization data must be in the same 
plate map layout as the Normalization Values table. 

2 Select the normalization data and copy to the clipboard [Ctrl+C].

3 Open an assay result file in Wave Desktop. 

4 Click Select All > Paste.    

5 Click Apply. 

Option #2:

1 Open an assay result file in Wave Desktop. 

2 Click Normalize. 

3 Manually type each normalization data point into the Normalization table.

4 Click Apply. 

Background wells should be left blank on the Normalization Table. 
NOTE
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Normalization unit

Before you can apply normalization values to rate data, a Normalization Unit 
is required. The Normalization Unit is displayed on the Y1 axis title on the 
kinetic graph when normalization is applied and checked ON.

For example, adding µg Protein to the Normalization Unit field will update rate 
displayed for Y1 axis label to: (pmol/min/µg Protein). If you have added a 
Normalization Scale Factor as well, be sure to add the scale factor value to the 
Normalization Unit field. 

Normalization scale factor

The Normalization Scale Factor allows you to scale normalized data to a 
specific factor, such as cell number. It is often preferable to normalize to an 
average or rounded number. 

Enter a scale factor value to recalculate and multiply normalized rate data 
based on the equation shown below: 

Normalized Rate (well)=[Rate (well)/(Normalization Value)]*Normalization Scale Factor

For example, if assay wells contain values of 12052, 12503, and 12757 cells per 
well, a user might enter 12000 as the normalization scale factor. 

Be sure to enter the same value in the Normalization Unit field to display the factor 
NOTE
correctly on the y-axis. For example, if using cell count and the scale factor is 10000, enter 
10000 cells as the Normalization Unit. After clicking Apply, the Y1 axis will display OCR as 
(pmol/min/10000 cells) rather than OCR (pmol/min/cells)
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Viewing normalized data

The Normalization checkbox will become active on all analysis views after 
applying normalization data to your assay result file. Use the checkbox to 
quickly toggle the rate data display between non-normalized rates and 
normalized rates on the kinetic graph, scatter plot, and Plate Map. All data 
graphs will display the Normalization Unit entered. (See Figure 81.)

Figure 81 Normalized rate data in a kinetic graph
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Wave Data Export Options
Agilent Seahorse XFe
Assay result data can be exported from Wave for additional analysis, graphing, 
or other purposes. Use the Export button (from any analysis view) to display 
default export options. The most comprehensive data exports are the 
Microsoft Excel and GraphPad Prism options. The Agilent Seahorse XF Report 
Generators provide standardized analysis templates for each Seahorse XF 
Assay Kit. Export result data to an XF Report Generator to quickly create a 
customizable, shareable summary report of your results.  Be sure to select the 
XF Report Generator that applies to the type of assay you are analyzing (XF 
Assay Kit). 
Export to Microsoft Excel
Export assay result data to Microsoft Excel from Wave for additional data 
analysis or graphing purposes.

1 Click Export (in the Functions ribbon).

2 Click Microsoft Excel.

3 Choose a save location, and click Save.

Using the export function described above, there will be between 7–13 tabs in 
the exported Excel file depending on the data configured in Wave:

Raw data: Exporting raw result data (not normalized, baseline OFF) will have 
seven data tabs. (See Figure 82.)

a Assay configuration: Information from the assay result file including 
the Group Layout (Plate Map), Cartridge/Cell Plate Barcode and other 
information, Instrument Protocol, and normalization data and 
normalization unit.

Figure 82 Raw rate data

Rate (Plates) Tab: Raw OCR rates 
for rate measurement 1 (from an 
XFp Analyzer). 
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b Rate: Raw OCR, ECAR, and PER or PPR data in a column format 
organized by measurement. 

c Rate (Columns): Raw OCR, ECAR, and PER or PPR data in a column 
format organized by group. Similar output format to the GraphPad Prism 
export.

d Rate (Plates): Raw OCR, ECAR, and PER or PPR data organized by 
measurement displayed as a Plate Map.

e Raw: Raw assay well data for temperature, emission values and 
reference values. Often used for troubleshooting by Agilent Cell Analysis 
Technical Support.

f Calibration: Raw calibration data for both the O2 and pH channels.

g Operation log: List of each protocol command executed by the analyzer, 
timing of the command, and outcome (success/fail).

Normalized data: Exporting result data that has been normalized (baseline 
OFF) will have three additional data tabs in the Excel export. (See Figure 83.)

a Normalized rate: Normalized OCR, ECAR, and PER or PPR data in a 
column format organized by measurement. 

b Normalized rate (Columns): Normalized OCR, ECAR, and PER or PPR 
data in a column format organized by group. Similar output format to the 
GraphPad Prism export.

c Normalized rate (Plates): Normalized OCR, ECAR, and PER or PPR data 
organized by rate, displayed as a Plate Map.

Figure 83 Normalized rate data

Normalized Rate (Plates) Tab: 
Normalized OCR rates for rate 
measurement 1 (from an XFp 
Analyzer). 
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Baselined data: Exporting result data with baseline ON (recalculated as a 
percent of a rate measurement or of a control group) will have three additional 
data tabs in the Excel export. (See Figure 84.) 

a Baselined rate: Baselined (%) OCR, ECAR, and PER or PPR data in a 
column format organized by measurement. 

b Baselined rate (Columns): Baselined (%) OCR, ECAR, and PER or PPR 
data in a column format organized by group. Similar output format to the 
GraphPad Prism export.

c Baselined rate (Plates): Baselined (%) OCR, ECAR, and PER or PPR 
data organized by rate, displayed as a Plate Map.

Excel export legend

The legend on each tab indicates the assay wells that have been excluded from 
calculations in Wave (turned OFF or unassigned). (See Figure 85.) Assay well 
B in the images below was turned OFF in Wave before exporting to Excel. 

Figure 84 Baseline rate data

Figure 85 Plate map legend in Excel export

Baselined Rate (Plates) Tab: 
Baseline OCR rates for rate 
measurement 1 displayed as a 
percentage (from an Agilent 
Seahorse XFp Analyzer). 
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Export select graph data to Microsoft Excel (from any analysis view)

To export customized analysis views in Wave (or specific sets of data from 
Wave) to Microsoft Excel right-click on a graph (or plate map) to display the 
Excel export option. 

1 Right-click anywhere on a chart or Plate Map to display an option menu and 
select Export Graph Data to Excel. (See Figure 86.) 

2 Browse to the desired save location, type in the file name for the export. 

3 Click Save. 

The data values exported to Microsoft Excel will be in the exact same format 
as they are displayed on the chart or Plate Map. 

Figure 86 Option menu

This Microsoft Excel file export is not compatible with the XF Report Generators. Use the 
Export to GraphPad Prism

NOTE
Export button in Wave software to export data directly to the XF Report Generators from 
any analysis view.
Export assay result data to GraphPad Prism for additional data or statistical 
analysis, or graphing purposes.

1 Click Export (on any analysis view).

2 Select GraphPad Prism. 

3 Choose a save location, and click Save.

Prism export compatibility has been validated using GraphPad Prism 7.
NOTE
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GraphPad Data tables

Wave exports rate data (OCR, ECAR, PER or PPR) to GraphPad as: 

• Raw rate data: always exported

• Normalized rate data: Normalization data must be applied to the assay 
result file in Wave before export

• Baseline rate data: Rate data as a percent of the selected baseline 
measurement or control group

Sample data output in GraphPad Prism from an XFp Analyzer with two assay 
groups, Disease Group and Healthy Group. (See Figure 87.)

• Column-format Data Display: Time is a fixed column next to the assay 
groups, and will scroll horizontally when there are more assay groups. 

• Assay Wells and Columns: The number of columns with rate data (below 
each group header) reflects the number of assay wells in each group. 

Figure 87 Prism data output
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• Excluded Assay Wells: Assay wells that have been excluded in Wave will 
appear as an empty column in Prism. Column A:Y3 below Group A (called 
Disease Group) in Figure 87 on page 85 shows rate data that has been 
exported for two wells in the Disease Group. Refer to Project Info or the 
assay result file in Wave for excluded assay wells in the exported Prism file. 

• Rows and Rate Measurements: The number of rows reflects the number of 
rate measurements captured during the assay. In Figure 87 on page 85, 
there are a total of 16 measurements performed during the assay (16 rows). 

GraphPad Kinetic graphs 

Every Data Table in the GraphPad Prism file export also contains a 
corresponding kinetic graph. The graph in Figure 85 represents the data set on 
the previous page from the XFp Analyzer. The Graphs folder displays the 
available kinetic graphs based on the type of data exported from Wave, that is, 
raw data, normalized data, or data as a percent of the baseline. Assay wells or 
groups that are turned OFF in Wave prior to export will be excluded from the 
file export.

GraphPad project info 

Information about the experiment and assay properties is displayed in Project 
info 1 (in the Info folder) including the date the assay was performed, the 
assay result file name, and normalization unit. (See Figure 86.) The Notes 
display on the Project Info view shows the group layout, assay wells in each 
group, and indicates excluded assay wells using brackets (example: [A2]).

Figure 88 Kinetic graph in Prism export

Figure 89 Prism Project info view
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Export to Agilent Seahorse XF Report Generators
Agilent Seahorse XFe
XF Report Generators are Microsoft Excel macro files that automatically 
calculate the parameters of each XF Assay Kit. Result data is presented in a 
one-page, customizable Summary Report. Wave provides a one-click direct 
export of result data to the Report Generators. Any modifications in Wave will 
be incorporated in the exported Report Generator file, such as excluding assay 
wells from a group and normalized rate data.

The six XF Report Generators available for direct-export in Wave are:

• XF Real-Time ATP Rate Assay Report Generator

• XF Glycolysis Stress Test Report Generator

• XF Glycolytic Rate Assay Report Generator

• XF Cell Energy Phenotype Report Generator

• XF Cell Mito Stress Test Report Generator

• XF Mito Fuel Flex Test Report Generator

Figure 90 XF Report Generators in the Export menu

XF Report Generators are validated for compatibility with Microsoft Excel 2010, 2013, and 
NOTE
2016 on Windows PCs and Excel for Mac 2011 and 2016 for Apple computers.

For more information about a specific XF Report Generator, refer to the appropriate Report 
Generator User Guide on the Agilent website.
Export data to an XF Report Generator

1 Open assay result file and modify data as necessary.

2 Click Export.

3 Select the XF Report Generator that matches the assay kit you ran.
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4 Enter a file name if desired, select a save location, then click Save. The 
default name of the exported Report Generator file will match the assay 
result file name. 

5 Open the Report Generator file, and select groups to display. The Select 
Groups dialogue box is displayed automatically the first time data is 
exported to the XF Report Generator.

6 To save the Summary Report, click Save.

When exporting an assay result file that has data from two different assays on the same 
NOTE
Cell Plate (such as a Agilent Seahorse XF Cell Mito Stress Test and Glycolysis Stress Test), 
turn OFF groups that do not apply to the Report Generator you are exporting to first. Repeat 
the same process for the other assay groups and Report Generator.
Best practices for exporting data to the Agilent Seahorse XF Report Generators 

Enable Macros in the Trust Center Before using an XF Report Generator, 
macros must be enabled. Macros are disabled with notification in the 
Microsoft Excel Trust Center by default. Opening a newly-exported Report 
Generator will display a security warning to enable the macro. To use the XF 
Report Generator, click Enable Content. This must be enabled for subsequent XF 
Report Generator file exports. 

To always enable macros and not be prompted to Enable Content each time a 
Report Generator file is created, enable all macros in the Microsoft Trust 
Center.

1 Open Microsoft Excel.

2 Click File>Options.

3 Click Trust Center>Trust Center Settings.

4 Click Macro Settings.

5 Select Enable all macros, and click OK.

Exporting normalized data to a Report Generator Normalized rate data in Wave 
will be exported and used for parameter calculations in the Report Generator. 
Normalized data is displayed by default after selecting groups to display. To 
toggle the rate data display between normalized and raw data, use the 
Normalize button on the Summary Printout page. The Normalize tab in the 
Report Generator will display the normalization values, unit, and scale factor 
as exported from Wave. (See Figure 91 on page 89.) For data integrity 
purposes, normalization values (displayed on the Normalize tab) cannot be 
edited within the Report Generator. To change normalization values in a 
Report Generator, you must first edit the normalization values in Wave, then 
re-export data to the selected Report Generator. 
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The Normalize tab in the Report Generators provides a step-by-step explanation 
on how to edit the normalization values imported to the Report Generator. 
(See Figure 92.) 

Excluded assay wells in Report Generator Assay wells that are turned off in 
Wave will not be exported or included in parameter calculations for each 
group in the Report Generators. This also applies to entire groups in an assay 
result file. Groups turned off in Wave will not be exported to selected Report 
Generators. The Measures Sheet displays the group names, Plate Map layout, 
and any assay wells that have been excluded in the group calculations in the 
Report Generator. (See Figure 93.)

Figure 91 Report Generator normalize tab

Figure 92 Instructions to edit the normalization values

Figure 93 Measures sheet
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Summary View
90
The Summary view is always listed in the upper-left corner of the open 
analysis Views section on the ribbon (next to Add View). The Summary view is 
always added to every assay result file and cannot be deleted. The purpose of 
the Summary view is to record important notes or information about the open 
result file.  You may also append graphs, charts, Plate Maps from other open 
analysis views, or add details of the Instrument Protocol or 
Groups/Conditions used in the assay. The Summary is the only location in 
Wave that enables export to Microsoft Word, Adobe PDF, HTML, or Rich Text 
Format (.rtf). (See Figure 94.)
Customize the summary

Figure 94 Summary view
Use the ribbon toolbar to add, edit, and format the content added to the 
Summary, such as:

• Cut, copy, and paste to the clipboard.

• Change the font type, size, text, highlight color, and style.

• Subscript or superscript a character or characters.

• Add bullet points or numbers.

• Insert a table, picture or page break.
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Append to summary

Append content from any analysis view directly to the Summary in three ways:

• Append to Summary: Click Summary (in the Functions ribbon) on the Quick 
View, Overview, OCR vs. ECAR views to send all data on the current 
analysis view to the Summary.

• Right-click > Send to Summary: Right-click a kinetic graph, scatter plot, or 
Plate Map and click Append to Summary from the drop-down list. To view 
appended content, click the Summary view. 

• Append Image (Summary view): General Information: The General 
Information button appends an image to the Summary view containing 
information about the assay, including project and plate information.

• Protocol Summary: The Protocol Summary appends the Instrument 
Protocol (Mix, Wait, and Measure steps) as well as the time and number 
of cycles for each measurement to the Summary view. 
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• Group Summary: The Group Summary button appends an image of the 
Plate Map and a table of the Group Definitions to the Summary view. The 
Plate Map is shown below. 

• Port Summary: The Port Summary button appends an image to the 
Summary view of the contents injected from each compound port in the 
assay.
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Print and Export summary
Agilent Seahorse XFe
To print the Summary view, click the Print button on the Summary toolbar, 
select the printer to use, and click Print.

Export the contents of the Summary view to a Microsoft Word Document, PDF 
file, HTML file, or Rich Text Format file. Click the appropriate icon from the 
Export section of the Summary toolbar, browse to the desired file location to 
save and click Save. 
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Data View
94
The Data view contains every piece of data associated with assay result file 
organized into 7 tabs:  

• Group Data: OCR, ECAR, PER, or PPR rate data and error values organized 
by group, and ordered by measurement.

• Rate: OCR, ECAR, PER or PPR individual assay well data. Error values are 
not displayed.

• Level Data: Individual assay well data displayed as Level data - O2 level (in 
mmHg) and pH raw values.

• Raw: Raw data values obtained during the assay including LED values, 
temperature at each measurement, and internal LED reference values.

• Calibration: Calibration results for each assay well are displayed in a table 
format.

• Calibration View: Calibration results for each assay well are displayed in a 
Plate Map format.

• Event Log: XF Analyzer serial number, consumable lot numbers used 
during assay, a command log for processes performed during assay, and 
whether they were successful or failed.

Export the data in a selected tab to Microsoft Excel using the right-click Export 
function. The Calibration, Raw, and Event Log tabs are used primarily for 
internal purposes, including QC, validation processes, and Agilent Cell 
Analysis Technical Support.

To display the Data view, click Add View on the top-level ribbon and select Data 
from the drop-down menu. The Group Data tab is displayed by default when 
opening the Data view. (See Figure 95 on page 95.) 
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Figure 95 Data view
Column sorting
To sort the data by a specific column, click on the column header: 
Measurement, Group Name, Time, Rate or error for OCR, ECAR, or PER/PPR. 
Wave will automatically sort the data in ascending or descending order in the 
selected column. 
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Display values for: Average, Count, Maximum, Minimum, or Sum
96
To display the Average, Count, Maximum, Minimum, or Sum, or any 
combination of these values, click the Sigma sign to the right of the arrow, and 
check the applicable boxes. In the example shown below, all values are checked 
for OCR data - Wave will display the average, count, maximum value, minimum 
value, and sum for the OCR data.
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Group Data by Field
Agilent Seahorse XFe
To group the data by field, drag and drop a column header to the gray bar 
above the table. In the example shown below, the Group Name heading was 
dragged to the gray bar. After grouping the data, expand or collapse the group 
by clicking on the plus/minus sign to the left of the group.

After expanding a group, select another column heading to define the 
groupings further. In the example below, the heading OCR was dragged to the 
grey bar after Group Name.
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Wave Home: Templates
100
Manage the list of available templates for your XFe and XFp Analyzer on the 
Templates view, Figure 96, by using the Import, Export, Duplicate, and Delete 
buttons.
Import assay templates 

Figure 96 Wave Home > Templates view
Import assay template files to Wave two ways: 

• Double-click the assay template on a USB flash drive, network drive, or 
shared in an email, and the template will automatically import to the 
Templates view.

• Open Wave > Templates view and click Import. Locate the assay template file, 
then click Open.
Export, duplicate, and remove assay templates
Select (single-click) an assay template on the Templates view to:

• Duplicate: Create an identical copy of a template. 

• Delete: Permanently delete an assay template file from Wave. 

• Export: Export an assay template to:

• A USB flash drive

• A shared network directory for multiple user access
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Template Details
Agilent Seahorse XFe
To display details about an assay template without opening the file, 
single-click the template to display Template Details. (See Figure 97.) The 
Modified date reflects the most recent date the template was modified and 
changes were saved. Description, Project Name, Project Number, and Investigator 
are optional details and not required to save a template.

Figure 97 Template Details
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Wave Home: Results 
102
The Results view, Figure 98, displays recently opened assay result files, the 
corresponding file directory where each assay result file is located, and 
Favorite Places. Opening a new assay result file displays the default analysis 
view, the Quick View. After modifying and saving an assay result file, Wave 
automatically displays the last modified analysis view the next time the assay 
result file is opened. 
Figure 98 Wave Home > Results view
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Recent assays, recent places, and favorite places
Agilent Seahorse XFe
• Recent Assays displays a sortable and searchable list of recently viewed and 
analyzed assay result files. (See Figure 98 on page 102.)

• Favorites displays user-defined locations (local or network directories) 
where assay result files are frequently added to, or accessed from. Once 
configured, each local directory added as a Favorite Place will appear below 
Recent Assays as a folder icon. (See Figure 99.)

• Recent displays the file location (for both local and network directories) of 
recently opened assay result files in the order of when each result file was 
opened. (See Figure 99.)

Figure 99 Recent Assays, recent places, and favorite places
Options
Click Options, next to Browse in Figure 98 on page 102, to add Favorite Places 
(that is, a shared network directory) or configure the number of Recent Folders 
and Recent Assay Files to display on the Results view. (See Figure 100.)

Figure 100 Edit result file display options
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Browse
104
To manually open an assay template or assay result file, click Browse. (See 
Figure 98 on page 102.)

The file types compatible with Wave 2.6 are:

• Assay result files (*.asyr)

• Assay templates (*.asyt) 

• Agilent Seahorse XF data files (*.xfd)

Double-click to open an assay design file (*.asyd) created by earlier versions of Wave and 
Sort by 

NOTE
Save As an assay template file. It is not possible to create assay design files using 
Wave 2.6. If you have *.asy files, these must be converted to *.asyr before opening in Wave. 
Contact Agilent Cell Analysis Technical Support for help with this.
Assay result files are default-sorted by Most Recent, which displays a list of the 
most-recently opened or modified assay result file first. Name sorts assay 
result files alphabetically based on the file name and Instrument sorts by the 
type of XF Analyzer used to generate the assay result file.

Figure 101 Results file sorting options
Search
Type specific keywords in the Search bar to filter and display assay result files 
whose file name contains matching keywords. Searching using the file 
directory or date is not supported. 

Figure 102 Search from the results view
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Wave Home: Catalog
Agilent Seahorse XFe
The Catalog provides a location to save frequently used Compounds, 
Pretreatments, Media, and Cells. (See Figure 103.) Save time when creating a 
new assay template or customizing a template file by inserting Catalog entries. 
The Catalog is prepopulated with reagents and compounds that are used in 
commercially available Agilent Seahorse Assay Kits. 
Add a catalog entry

Figure 103 Wave Home > Catalog view
1 Open the Catalog view.

2 Select a condition (Compounds, Pretreatments, Media, and Cells). This example 
used Pretreatments.

3 At the bottom of the Catalog > Pretreatments view, type in a Name (required), 
and any additional fields to describe the Pretreatment entry (optional).

4 After adding details, click Add Pretreatment to save the entry.

5 When finished, click Save in the lower-right corner of the Catalog view.
Delete a catalog entry
1 Open the Catalog view.

2 Click the red X at the end of the row to delete.
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Share custom catalog
106
Share a custom Catalog for upload to Wave Controller (XFe Analyzer) or 
another user's Wave Desktop.

Computer #1:

1 Plug in the USB flash drive (if applicable).

2 Start Wave, and open the Options view.

3 The Catalog directory is found under the Directories header on the General 
Options view. 

4 Highlight the path and copy/paste into Windows Explorer to display the 
Catalog folders: CellLine, Compound, Pretreatment, and XFeMedia.

5 Select each Catalog condition to share and copy/paste to the USB flash 
drive (or a network directory). Do NOT cut the Catalog entries.

6 Eject the USB flash drive (if applicable).

Computer #2:

1 Insert the USB flash drive (or open the network directory) containing the 
saved Catalog entries.

2 Start Wave, and open the Options view.

3 In General Options, copy/paste the Catalog directory location in Windows 
Explorer.

4 Close Wave.

5 In Windows Explorer, open each Catalog folder (from Computer #1), and 
copy/paste the contents into the appropriate Catalog folder on 
Computer #2.

6 Eject the USB flash drive (if applicable) and open Wave.

7 Open the Catalog view, and verify the transferred entries are displayed in 
the list for each condition. 
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Wave Home: Options
Agilent Seahorse XFe
The three types of modifiable settings in the Options view are: General, 
Instrument, and Advanced. (See Figure 104.)

Figure 104 Wave Home > Options view
General settings 
General settings displays options to:

• View/change the default Wave file directories (save locations) for the 
Catalog and assay templates files. 

• Modify the reported acidification rates - PER (default) and PPR.

• Enable/disable the What’s New pop-up (list of new features) upon startup of 
Wave software. 

• Enable/disable automatic Wave software updates.

After making changes to General options, click Save (lower-right corner) to save 
changes. To restore changes to the factory default setting, click the Default 
button.

Directories

Directories displays the default save location for Catalog entries and Template 
files. (See Figure 104.) The prepopulated Catalog conditions and assay 
template files installed with Wave are stored in this directory, as well as any 
new Catalog entries and assay template files. To change the location of either 
directory, click the […] button to browse to the preferred location. Wave 
software must be restarted for changes to take effect.
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What’s new message box

The What’s New message box appears upon Wave startup, and displays the new 
features and functions in the version of Wave software you are running. This 
message box will always appear unless either the Don’t show this again box is 
checked, or it is disabled in the Options view.
Instrument options
Instrument options displays default values (by analyzer type) for the 
Instrument Protocol. (See Figure 105.) To change the XF Analyzers displayed 
in Wave Desktop, see the Wave Desktop 2.6 ReadMe PDF. 

Other settings that can be modified include: 

• Cycles: Number of repeat Mix, Wait, and Measure cycles in the default 
protocol

• Mix, Wait, and Measure times: Time to complete each command in the 
Instrument Protocol

• Default Well Volume (notation purposes only) 

Protocol defaults

Leave the default Protocol Defaults untouched, and modify the Instrument 
Protocol in the individual assay template file. To change the Protocol Defaults: 

1 Use the up/down arrows or type in the new values for Mix, Wait, Measure, 
and Cycles.

2 Click Save at the bottom of the screen to save changes.

Figure 105 Instrument options
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Well Volume

The port and well volumes are unique to each Seahorse XF analyzer. Modifying 
these values does not change the function of the analyzer or calculations, and 
are for record-keeping only. During an assay, the contents of the port will be 
injected. To change the Well Volume:

1 Use the up/down arrows, or type the new value in the Well Volume fields. 

2 To save changes, click Save.
Advanced options (Wave Controller software only)
Wave Controller (for XFe Analyzers only) can be configured to automatically 
notify users when certain functions are complete or require attention, such as:

• Calibration: Calibration is complete, it is time to replace the Calibration Plate 
with the Cell Plate and start the assay.

• Assay Complete: Following completion of an assay, Wave Controller will 
automatically email the assay result file to the specified email addresses.

An active internet connection on the XFe Analyzer is required for use of 
automatic email notification features. (See Figure 106.)

Add email recipients

1 Type an email address in the Mail From field, and enter a password for this 
address in the Password field. This email address will be used to send all 
notifications and will be displayed in the Mail From field after receiving a 
notification from the XFe Analyzer.

2 Specify the SMTP Address and the access Port field.

3 Check Enable SSL if required by the local IT group.

4 Type the email address for a single recipient in the Recipient Email Address 
field.

5 Click Add.

6 Repeat Steps 4 and 5 for each recipient.

7 When finished adding recipients, click Save. 

Figure 106 Automated Email features
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8 To send a test notification email to all email recipients, click Test Settings. If 
the test email is not received, verify the correct network settings have been 
configured in Wave Controller. 

Remove email addresses 

Select the email address under Email Recipients, and click Delete. 
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Wave Home: Help
Agilent Seahorse XFe
To quickly and easily send system files for support and diagnostic purposes, 
the Help view displays software version information, Agilent Cell Analysis 
Technical Support contact information, and Send System Files. (See Figure 107.)
Send system files

Figure 107 Wave Home > Help view
Use the Send System Files function automatically compiles Wave System Files 
into a compressed folder, to Agilent Cell Analysis Technical Support. (See 
Figure 108.)

Save system files in a compressed folder: 

1 Open the Help view.

2 Click Send System Files.

3 Click Save to select a file location to save the compressed folder.

Figure 108 Send system files function
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Send system files to Agilent Cell Analysis Technical Support:

1 Open the Help view.

2 Click Send. An email message will appear populated with the following 
information:

a Email Recipient - Agilent Cell Analysis Technical Support email address.

b Subject - Email subject line.

c Email Body Text - displays the default save location of the System Files 
on the local drive.

3 Locate the saved System Files compressed folder, and attach it to the email.

4 Click Send.
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